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While helping 👪 family, friends and 👥 colleagues on various projects, we have learned some 

things.  In an attempt to keep these processes repeatable, and keep myself organized, I 📝 

record and maintain some helps on this subject.  For information on 🌲 green or < /> other 

programming subjects, please see a list of this document's sister docs. 
 

Education 
 Free college courses online. 
 Free public-domain books online. 

 

 List of local institutions at www.ericpiehl.com. 
 

General 
 Recommendations for running a safe computer as an end-user (antivirus, antispyware, 

backup, etc.), in my other document "Protect your 📱 smartphones, tablets and 💻 

computers from spam and malware, via antivirus". 
 

 Under Microsoft Windows, reboot (1) before installing software if you have been working for 
a little while, (2) between installing or upgrading any two software products, and (3) after 

your last install (some wiggle room). 
 

 On your Android device, install a security app such as Lookout Mobile.  Although … 

 
 Before attending any protests that might get you arrested, read and follow the EFF's 

recommendations about mobile cell phones at protests.  If you have an Android mobile 
phone, please see Whispercore and www.networkworld.com/news/2012/051412-android-
259182.html.  Support to protestors and journalists and my general article "Demonstrating 

protesting traveling in 🛂 heavily-policed or authoritarian areas, or when targeted by 

adversaries." 
 

 To search for people from phone numbers, see: 
o https://duckduckgo.com/?q=aaa-eee-nnnn, 
o https://google.com/search?q=aaa-eee-nnnn, 

o https://goo.gle/search?q=aaa-eee-nnnn [?], 
o https://g.co/search?q=aaa-eee-nnnn [?], 

o https://www.spokeo.com/reverse-phone-lookup, 
o https://www.whitepages.com > reverse phone, 
o www.whocallsme.com/Phone-Number.aspx/aaaeeennnn. 

o From cell mobile number. 
o Some more formats > scroll down to section Google Phonebook. 

o Description:   
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 https://www.linkedin.com/, 
 http://www.zabasearch.com/phone/aaaeeennnn. 

o http://resource.referenceusa.com/about-us/ via local library? 

 To find email addresses from names. 
 Find people.  Or here.  Or here. 

 All kinds of information. 
 Niche search engines. 
 If you have to, can use this sleazy site > button Search .... 

 
 Laws of Programming.  As far as I know, the first law, I came up with myself.  The 

second, I probably got from somewhere else, but have used it with coworkers so long that I 
can no longer remember to where to attribute them.  So until I get better attribution: 

o Eric's first law: Any useful computer program must be modified. 
o Eric's second law: Leave some functionality for Release 1.1. 
o Smiths/GE: Any computer development project takes longer and costs more. 

 

 To schedule group meetings, use www.doodle.com. 

 
 To send SMS text messages from an emailer: 

o freecarrierlookup.com http://freecarrierlookup.com/ 

o freesmsgateway.info http://www.freesmsgateway.info/ 
o https://lifewire.com/how-to-email-a-text-4147467. 

 
 More tools at http://pcsupport.about.com/od/software-tools. 

 

 “Library of millions of free books, movies, software, music,” and website Wayback 

Machine (not the same as 🍎 Apple Time Machine) at the Internet Archive. 

 Free public-domain books online. 

 Free movie streaming. 
 
 Statistics, health, disease, vectors, aphids https://influentialpoints.com/. 

 

Weather 
 App https://MyRadar.com. 

Weather (for now, USA-only and nearby areas, sorry) 

 Emergency NOAA weather-alarm radio 

http://ericpiehl.altervista.org/antivirus.pdf#page=25  section 5 "Emergency situations:   

⛑ search and rescue SAR, earthquake, flood, 🌪 tornado, 🌀 hurricane". 

 Big-picture map https://www.wpc.ncep.noaa.gov or 
https://www.wpc.ncep.noaa.gov/national_forecast/natfcst.php or 

https://www.nws.noaa.gov/outlook_tab.php. 
 Best forecast, no ads https://weather.gov. 

o Local https://weather.gov or https://forecast.weather.gov/zipcity.php > 
upperleft=yourZipCode > Go. 

o Also good, no ads https://weather.gov/yourLocalAirportCode > scroll down > Weather 

Map (each tab) or Weather Story. 
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o https://weather.gov/alerts > alert type > all or your state or zone or county. 
o https://graphical.weather.gov. 
o https://radar.weather.gov. 

o https://airquality.weather.gov. 
o https://aviationweather.gov. 

o For hourly weather forecast graphs, on above, right-click the barchart thumbnail > 
Open in new tab.  If that service is temporarily down, use 
http://forecast.weather.gov/MapClick.php?lat=42.98949&lon=-

85.49941919999998&unit=0&lg=english&FcstType=graphical (put in your latitude and 
longitude). 

o Useful GOES imagery http://www.goes.noaa.gov/ECIR3.html. 
o For satellite photos (let you see how thick the clouds are, to gauge how fast the rain or 

snow might fall), on above, right-click the satellite thumbnail > Open in new tab > scroll 

down > click link “Color Enhanced Image #3”. 
o Eclipse (deprecated) https://weather.gov/source/crh/eclipse.html. 

 Show weather forecast along your trip www.wunderground.com/wundermap#roadtrip. 
 The 6 Best Weather Apps for your Phone. 
 Misery index current 

https://earth.nullschool.net/#current/wind/surface/level/overlay=misery_index > drag 
around, zoom in, and click on your location. 

 Heat index https://www.wpc.ncep.noaa.gov/heat_index_MAX.shtml. 
 Heat Index v humidity:  https://wrh.noaa.gov/psr/general/safety/heat/heatindex.png 

and https://wikipedia.org/wiki/Heat_index. 

 Dewpoint v humidity: 
o DewPoint°C = Temp°C - (100-RH)/5. 

o DewPoint°F = Temp°F - (100-RH)*9/25. 
o RH = 100 - 5*(Temp°C - DewPoint°C). 
o RH = 100 – 25/9*(Temp°F - DewPoint°F).  -- https://wikipedia.org/wiki/Dew_point 

Dewpoint Dewpoint Comfort 

  >21°C   >70°F Oppressive for people accustomed to temperate climates 
[wiki]. 

  >18°C   >65°F Lots of moisture in the air, becoming oppressive 
[weather.gov]. 

  >18°C   >65°F Uncomfortable if accustomed to tropical climates [wiki]. 

  >15°C   >59°F Uncomfortable if accustomed to temperate climates [wiki]. 

13-18°C 55-65°F "Sticky" with muggy evenings [weather.gov]. 

10-15°C   50s °F Dry and comfortable [Eric]. 

-5-15°C 24-60°F OSHA at 20-24.5°C (68-76°F) [wiki]. 

  <13°C   <55°F Dry and comfortable [weather.gov]. 

 
 Sunset, sunrise, and twilight times (civil, nautical and astronomical), for your location 

https://planetcalc.com/300  > scroll down to "Sunrise and sunset calculator". 
 

Maps 
 https://google.com/maps/place/nnnn+street,+city,+state+zip 
 https://google.com/maps/place/urlencode(name+to+search)  works sometimes 

 https://google.com/maps/search/?api=1&query=urlencode(name+to+search) 
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 https://google.com/maps/search/?api=1&query=(43.035838,-85.490425) (put in your 
latitude and longitude). 

 https://maps.google.com/maps?q=urlencode(name+to+search)&f=q&lci=bike  bikes! 

 
 Directions https://google.com/maps/dir/?api=1&destination=urlencode(target+address) 

or https://maps.google.com/?saddr=Current+Location&daddr=urlencode(target+address) 
 Parking https://parkopedia.com. 
 Smoke https://fire.airnow.gov 

 Genealogy, small towns, nearby towns in various languages, nearby airports, recent 
weather http://fallingrain.com/world/a/K/a/l/i/s/h/ or 

https://google.com/search?q=Starobin+site%3Afallingrain.com, e.g., 
http://fallingrain.com/world/US/MI/Ada.html. 

 

 Michigan traffic/road construction map https://mdotjboss.state.mi.us/MiDrive  > toggle 
on traffic camera layer > select your favorite cameras.  From MDOT. 

 Consumers Energy electricity outage map https://consumersenergy.com/outagemap 
 Kent Co traffic incident map    https://accesskent.com/traffic. 
 Kent Co police and fire incident map  https://arcg.is/0408iT. 

 
 Pennsylvania driving conditions, including collisions and construction, https://511pa.com. 

 

Flight info 
 Fare finder https://skyscanner.net. 

 Choose seats in accordance with https://seatguru.com. 
 Can tell others (or your phone) to follow flight with: 

o FlightAware > yourFlight, in form https://flightaware.com/live/flight/sssnnnn (easy, 
may show ahead or behind). 

o FlightRadar24, in form https://www.flightradar24.com/data/flights/aaannnn. 

o PlaneFinder > Map Options > plane=yourFlight, in form 
https://planefinder.net/flight/aaannnn (projects current position based on position and 

velocity 6 minutes previous, uses ADS-B). 
 Status of your airport https://www.fly.faa.gov. 

 

Editors (doc) 
Fat-client (installed) software (review): 
 Microsoft Office/Microsoft 365, great, $.   

If eligible, save money by: 
  (A) downloading via deals with certain employers, or 
  (B) with the "Education" packages, often through your school. 

o For Microsoft Office Online (review), free, see next paragraph "cloud-based". 
o Verify your version has all the subunits you need:  real Outlook, Visio, SQL Server, etc.  

o If you have Office XP, 2000 or 2003, install the Microsoft Office Compatibility Pack for 
Word, Excel, and PowerPoint 2007 File Formats. 

o No current need to upgrade from Office 2007 or 2010. 
o Other Microsoft Office free downloads. 
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o Microsoft stopped selling Office, because they found they could make more money from 
yearly subscriptions, which they branded Microsoft Office 365.  And now I hear that, as 
of 2020-04, MS Teams has been added to MS Office 365, and branded Microsoft 365. 

o Some versions may include Microsoft Office Publisher, $, publishing and typesetting.  I 
use it for networking cards and a couple other projects. 

o Running Microsoft Office on 🐧 Linux. 

 "How to Use Microsoft Word for Free". 

 🍎 Apple iWork (formerly Productivity Apps), free on 🍎 Apple iOS, iPadOS and macOS.  

Components:  Pages (Word), Numbers (Excel), and Keynote (PowerPoint) (Keynote better 

for incorporating 📹 video, according to Rick Darke, presentation at OSU, 2021-02-06). 

 Apache OpenOffice, pretty good, free.  Mostly-equivalent to MS Office.  Maybe should 

use fork LibreOffice below.  Components:  Writer (Word), Calc (Excel), Impress 
(PowerPoint), Draw (Visio), Base (Access/SQL Server), and Math (equations). 

 LibreOffice, said to be very good, free.  Said to be similar to MS Office.  Components:  

Writer (Word), Calc (Excel), Impress (PowerPoint), Draw (Visio), Base (Access/SQL Server), 
Math (equations), and Charts. 

 SoftMaker FreeOffice review.  Components:  TextMaker (Word), PlanMaker (Excel), 
Presentations (PowerPoint), BasicMaker (VBA). 

 Adobe InDesign $, publishing and typesetting, I read is for plotters, mills and engravings, 

or for posters, flyers, brochures, magazines, newspapers, and books. 
 More alternatives.  13 Reasonable Alternatives to Adobe's Expensive Apps. 

 
Cloud-based, runs in a web browser window (Software as a Service SaaS) (review), may be 
good for collaboration (multiple people working on same doc at same time): 
 Prezi presentations are very nice, freemium. 
 Google Docs, Sheets and Slides, running on Google Drive (review), good, free.  If you 

have a Gmail email account, you already have access to Google Docs, Sheets and Slides 
through your email account.  The most common used parts of the above:  documents, 

spreadsheets and presentation. Can access from your Android phone.  Pretty good.  
Improving steadily;  I may have made my last upgrade of MS Office.  Components:  Docs 
(Word), Sheets (Excel), Slides (PowerPoint), Drawings (Visio), Forms and Fusion Tables 

(Access/SQL Server).  Spaces.  Forms.   
o For-profit organizations can pay for Google Workspace (formerly G Suite). 

o Nonprofit organizations can use Google Workspace (formerly G Suite) for Nonprofits, 
apparently still free after some paperwork. 

o Government agencies can also use Google Workspace (formerly G Suite) for free, after 

some paperwork. 
o People with no affiliations above can pay for Google Workspace (formerly G Suite), 

starting in 2021? 
o As Google Workspace (formerly G Suite) for Education tools enter classrooms across 

Canada, some parents are asking to opt out. 

 Microsoft Office Online (review), free, running on Microsoft OneDrive.  If you have an 
Outlook.com/Live Mail (formerly Hotmail) email account, you already have access to 

Microsoft OneDrive and Office Online through your email account.  Also through 
https://office.com > Sign In with your Skype, Microsoft or Office id.  (Options described 
in https://youtu.be/DuQyKM7_V-Y.  For full effect, select the video link, then icons ⛶ 

fullscreen, ㏄ captions, ▶ Play, and ⛶ ☒ Skip Ads.) 

Components:  Word, Excel, PowerPoint, Excel Surveys (forms), OneNote (drawings), and 
no database nor math equations. 
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 Comparison of above two. 
 
TODO: make a chart of the various office suites v. components. 

Purdue Online Writing Lab OWL, including MLA style guide. 
 

Spell- and grammar-check apps. 
 
To examine word use, use Wordifier. 

 
Free .pdf editors.  A .pdf filler site. 

 
Document converters, including .pdf to .jpg.  YouConvertIt. 
 

Editors (code) 
 The IDE you are going to code in: 

o Eclipse.  I love it, but steep learning curve.  TODO: try on PHP, SQL, html…. 

 If doing student embedded work, may need add-on Code Composer Studio 
CCStudio v5.  If doing pro stuff, see your real-time RT OS vendor. 

o Microsoft Visual Studio.  I love it, too, particularly for building fat client apps. 

o Komodo IDE. 

o Xcode for 🍎 Apple macOS.  Looks real good. 

o CodeStorm for 🍎 Apple macOS. 

o IntilliJ IDEA for 🍎 Apple macOS. 

 And/or a good colorizing program editor, such as: 

o Sublime text code editor looks great on 🍎 Apple macOS, Microsoft ⊞ Windows 

and 🐧 Linux. 

o Textmate for 🍎 Apple macOS.  Looks real good. 

o MacVim for 🍎 Apple macOS. 

o Notepad++ 5.8.5 www.wikipedia.org/wiki/Notepad++.  I love it.  –OR- 
o Textpad www.textpad.com (if you install, get add-on syntax files for your 

favorite languages, and set colors to something vibrant).  –OR- 

o gVim 7.3 if you like VI or 🐧 Linux and want function over prettiness.  –OR- 

o Nano for 🐧 Linux or 🍎 Apple macOS > Get Nano.  –OR- 

o Komodo Edit for HTML, CSS, JavaScript, JSP, PHP, XML.  No WYSIWYG.  –OR- 
o Microsoft VSCode Visual Studio Code.  –OR- 

o Editors that cost $$: 
 SlickEdit (more powerful than UltraEdit, but steeper learning curve). 
 UltraEdit (easier to learn than SlickEdit, but much clunkier source where-

defined Open Declaration or Go To Definition, and where-used Find All 
References features). 

o Some of these use powerful Search/Replace using Regular Expressions.  A 
learning curve, but doing so will save you LOTS of time on certain projects. 

 And maybe an application framework: 

o For smartphone platforms (Android, Blackberry, 🍎 Apple iOS, Palm, ⊞ Windows 

Mobile, etc.).  TODO:  Try out PhoneGap (more platforms, code in JS, CSS3 and 
HTML5) or Appcelerator Titanium (faster, compiles to native APIs). 
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How to Develop for iOS, Android, Windows and Mac at the same time :  
PhoneGap/Apache Cordova, Xamarin, Appcellerator, QT. 

o For all platforms. 

 
 Compare folders and files utility (you need one to keep the various versions of stuff 

straight!): 
o Beyond Compare (my favorite!), or 
o Total Commander (I haven't used it, but a guy I trust likes it;  it seems to have 

file management functions, too), or 
o something else I could download for free when I could not get a good one at 

work, or 
o compare feature in your editor, such as Eclipse or UltraEdit or SlickEdit. 
o These are good ways to enforce your folder and file naming conventions. 

 
 For batch mass-conversions, if ad hoc Replace-In-Files in your editor above isn't good 

enough, and you want Multiple-Replace-In-Files in batch, get ReplaceEm.  Or use Unix or 
GNU command sed. 

 

Troubleshooting tools and things to make your life easier 
 Check short URL and more short URL expanders for testing a suspicious link without clicking 

on it. 

 
 Winternals Sysinternals: 

o Process Explorer ProcExp or SourceForge Process Hacker.  Does everything that 

Microsoft Windows Task Manager can do, plus a lot more — find out: 
 which task has your file in use,  

 what task is using all your resources,  
 what a task's subtasks are,  

 see all network connections and ports and what processes are doing that 
(PH), 

 scan or analyze memory (PH), 

 etc. 
Way cool.  To install, follow first External Link.  Slow it down.  Link to PC Mag 

article. 
o Process Monitor ProcMon - a process and thread monitor.  Replaces old 

RegMon and FileMon.  Link to PC Mag article. 

o If your computer runs slower than it used to: 
 If you don't use www.malwarebytes.org anti-malware, install the free 

version, boot to Safe Mode, and run it. 
 Start wacking or delaying programs that start themselves automatically, 

using: 

 (easy) Norton Security Online (free with Comcast) > Tuneup > 
Startup Manager;  or 

 (moderate) msconfig (free on Windows) tab Startup (works fine, 
easier than below;  Windows 10 has nice link to where they moved it:  
Task Manager tab Startup);  or 

 (moderate) services.msc;  or 
 (don't remember) Winternals Autoruns;  or 
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 (moderate) find all your Startup folders, and move bad entries to new 
sister folder StartupNOT, 

 (expert) Registry entries HKEY_CURRENT_USER\Software\Microsoft\ 

Windows\CurrentVersion\Run and HKEY_LOCAL_MACHINE\SOFTWARE\ 
Microsoft\Windows\CurrentVersion\Run (delete the bad entries) (works 

great). 
 Use the other tools in msconfig (free on Windows) tab Tools, including 

mmc. 

 Until your system drive has at least 15% freespace, run Windows Disk 
Cleanup (or CCleaner Free [except in 2021, is identified by Microsoft 

Defender Antivirus as a PUP Potentially-Unwanted Program, and may 
recently be crapware] > turn off "Windows Explorer MRUs" > Run Cleaner, 
and then Tools > Duplicate Finder) (or Auslogics duplicate file finder), 

then move, compress or delete unneeded files. 
 Reboot, Defrag and reboot.  (There are at least two ways.) 

o runasuser.exe  
o PortMon - a serial and parallel port monitor 
o DiskMon - a hard disk monitor 

o DebugView TODO: expand on these.  Investigate RootkitRevealer. 
 

 Microsoft PowerToys 
o Open Command Window Here, save lots of time if you open DOS boxes ever. 
o Improved calculator, image tools, Alt-Tab replacer, all kinds of stuff I have found 

very helpful. 
o Need to try out function SyncToy, and KarenWare ptReplicator backup tool, for 

whenever my HP external harddrive gets too small.  TODO: expand on this. 
o Need to look into new function PowerRename, and Image Resizer. 
o Installer at https://github.com/microsoft/PowerToys/releases  > Assets > *.exe. 

 
 UNetbootin bootable USB drive, BIOS updater (how to use), partition manager, password 

resetter, anti-virus Rescue disk, and other cool tools. 
 If that doesn't work. 

 
 Bootable CD tool Paragon Software partition manager.  Said to (1) clone harddrives — even 

dodgy (failing) ones, and (2) resize partitions, e.g., to migrate to larger drive. 

 
 Bootable USB drive Kingston Technologies DataTraveler Workspace (Windows to Go). 

 
 Bootable CD Ultimate toolkit or bootable USB creator. 

 

 To burn or copy bootable CDs or bootable DVDs from ISO images, such as for your 
various Rescue CDs, please below in the File management section. 

 
 Microsoft offers bootable anti-malware:  Microsoft Defender Antivirus (was Windows 

Defender Antivirus) Offline tool. 

TODO:  Try the above, and Attack Surface Analyzer. 
Kim Komando keeps track of this stuff. 

  
 More free utilities for Windows from GNU. 
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 Harddrive testing programs. 
 
 Karen's Power Tools for Windows.  TODO: expand on this. 

 
 “Library of millions of free books, movies, software, music,” and website Wayback 

Machine (not the same as 🍎 Apple Time Machine) at the Internet Archive. 

 Wikibooks and Project Gutenberg. 
 Free movie streaming. 

 

 TODO:  investigate: 
o What's in your machine: 

 Sysinfo SI HWiNFO32 
 SIW System Information for Windows 

o Crap Cleaner. 

o Recuva locate deleted files and selectively undelete restore them, or 
Diskinternals uneraser. 

o Defraggler defragger. 
o VirtualBox desktop virtualization (way cool, I use it every week, need to write 

about it). 

 
 More in the Testing section. 

 

Unix tools that run under Microsoft Windows 

 Cygwin.  Runs a lot of Unix/🐧 Linux utilities.  Very useful, and good for automation. 

o Some of the above use powerful Search/Replace using Regular Expressions. 

o Nice 📹 video installation instructions by Calvin College Prof. Joel Adams. 

o TODO: expand on this. 

o 🐧 Linux command reference for your Android! 

 
 GNU Unix utilities for Win32 Windows DOS http://unxutils.sourceforge.net:  bc, bison, 

bzip2, diffutils, fileutils, findutils, flex, gawk, grep, gsar, gzip, indent, jwhois, less, m4, 
make, patch, recode, rman, sed, shellutils, tar, textutils, unrar, wget, which.  I find 
tar/bzip2 and sed very useful, and grep. 

o Some of the above use powerful Search/Replace using Regular Expressions. 
o Can get a subset of this functionality in a single binary in Swiss File Knife.  

 

Distributed-team 📹 video-conferencing apps 
 This section is much more up-to-date at my document "Preparing and showing ▭🌄 

presentations (for 👥 people who do this sporadically)". 

 "I have used about five different ones.  Most are fine, but you should have newbies install 

the software the day before, in case it doesn't work.  Some need to be rebooted after 
installation.  Wish I have kept notes as to which are which ... 

 Zoom Video Conferencing.  Installs right away!  If you have newbies log on 4 minutes 

before the meeting, you have a chance of getting everyone on! 
o > Meetings or Video Webinar. 

o Setup > Virtual Background. 
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o Meeting-recording option. 
 Google Meet https://meet.google.com (formerly, classic Hangouts video call). 
 Microsoft Skype, and Teams.  And now I hear that, as of 2020-04, MS Teams has been 

added to MS Office 365, and together branded Microsoft 365. 
 Cisco Webex Personal or paid;  Teams, Meetings, Events, etc. 

o Very functional.  Different room feature is way cool! 
o As of 2020-08, interface is a bit clunky, surprising since Webex created this 

marketspace. 

 GotoMeeting. 
 crowdcast. 

 More at sister document http://ericpiehl.altervista.org/present.pdf#page=2  section 1.2.1 
"First steps". 

 More thoughts in Consumer Reports article "Working from Home because of COVID-19?  

These Tech Ideas can make it Easier". 
 

Distributed-team chat apps 
 Slack. 

 

Remote Access 
 Remote Desktop Connection.  Will connect you to and take over a target PC without first 

having to install any VNC server software on the target machine. 

Comes already installed on Microsoft Windows Pro, Business or Ultimate versions.  Web 
says it not included on Windows Home versions.  Bizarrely, my Windows 7 Home Premium 
has the client (viewer) half, but not the server (target) half??? 

Includes mapping your local harddrives as virtual harddrives on the remote machine, for 
easy drag-and-drop without FTP.  Makes some stuff way easy! 

To use, see the good Microsoft help pages on that, to: 
o Set up the target (client) PC to allow it. 
o Run RDC server. 

 
 VNC Virtual Network Computing. First must install a VNC server on the target machine, and 

a VNC viewer on the remote machine.  Works very well, too. 
o RealVNC.  Free viewer.  My favorite for longer connections, such as over 2 

minutes. 

o UltraVNC.  Free viewer.  Nicer/easier dialog to get to the target versus RealVNC, 
but less easy to use for longer connections (over 2 minutes). 

TODO: expand on this. 
o TightVNC.  Recommended to me by people I trust, but I haven't installed it. 

 

 If you don't have RDC or VNC above, I read that LogMeIn works well, is free, and runs 
through a web browser.  You can pay for extra goodies, but the free version is said to be 

good enough for first use.  If you use this, please let me know;  maybe this belongs in the 
VNC paragraph above. 

 
 To hold webcasts: 

o Software from Cisco, on first use, has lots of teething pains. 
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o Software Zoom installs quick and easy. 
 

Networking 
 Check short URL and more short URL expanders for testing a suspicious link without clicking 

on it. 
 

 Ookla > Internet speed test for mobile and computers. 
 Look into https://speedtest.net.  Sometimes works OK.  Do not click on their many ads! 
 Look into https://speed.measurementlab.net from NDT Network Diagnostic Tools from 

Measurement Labs M-Lab. 
 NEW Google speed test https://google.com/search?q=speed+test > box Internet Speed 

Test button Run Speed Test. 
 Overlook Fing SSID and IP details, and speed of your current Wi-Fi connection;  network 

discovery, TCP port scanning, ping, Traceroute and DNS lookups;  on your Android!  I 

believe there is an iOS version, too. 
 More broadband internet speeds explained. 

 And see Ten Windows 10 network commands everyone should know. 
 
 Change your computer's DNS setting. 

 Network packet sniffer WireShark (works great). 
 Wi-Fi network packet sniffer NetStumbler (I should try this). 

 
 Wi-Fi Analyzer on your Android, I love this one.  Others.  Good tips. 
 Network analyzer for Android http://netalyzr.icsi.berkeley.edu/. 

 
 What is my IP address?  

o www.whatsmyip.org, plus “More Info About You” “Traceroute”, and other cool 
tools — lots of info, no ads. 

o https://duckduckgo.com/?q=my+IP 
o https://google.ca/search?q=my+IP 
o https://lifewire.com/192-168-0-1-818066 

 Whois the holder of this Internet domain, URL or IP address?  ("nslookup" or "whois" 

services): 
o Karen's Power Tools whois 

o www.whatsmyip.org > “WHOIS & DNS” 
o www.internic.net/whois.html  
o https://www.whois.com/whois /yourDomainNameOfInterest  minimal ads 

o http://www.internic.net/whois.html recommended by Apache and CentOS, 
forwards to https://lookup.icann.org/. 

o http://whois.domaintools.com /yourDomainNameOfInterest  lots of cool info 
o http://dnstoolkit.net/nslookup /yourDomainNameOfInterest 
o www.scamanalyst.net if they show anything, they show lots of cool info 

 And see Ten Windows 10 network commands everyone should know. 
 

 SharesFinder on your Android! 
 Default router passwords on your Android. 
 Seeing your actual Wi-Fi passwords. 

 Bandwidth monitoring tool Arpwatch, and other cool tools from http://ee.lbl.gov/.  
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 I really like the Wikipedia network tools, listed at the bottom of dotted-IP User_talk pages.  
As of 2011-05-30:   

o WHOIS www.toolserver.org/~chm/whois.php ?ip=yourDottedIpAddress 

o rDNS www.robtex.com/ip/ yourDottedIpAddress.html 
o Traceroute www.dnsstuff.com/tools/tracert/?tool_id=68 

&ip=yourDottedIpAddress 
o Geolocate www.ip2location.com/ yourDottedIpAddress 
o RIRs: 

 America http://whois.arin.net/ rest/ip/yourDottedIpAddress.html 
 Europe www.ripe.net/fcgi-bin/whois ?searchtext=yourDottedIpAddress 

 Africa www.afrinic.net/cgi-bin/whois ?query=yourDottedIpAddress 
 Asia-Pacific www.apnic.net/apnic-bin/whois.pl 

?searchtext=yourDottedIpAddress 

 Latin America/Caribbean www.lacnic.net/cgi-bin/lacnic/whois?lg=EN 
&query=yourDottedIpAddress 

 Registrar and domain name security check. 

 I haven't used this 🐧 Linux-based open-source diagnostic and monitoring Network Security 

Toolkit, but it looks interesting. 
 And see Ten Windows 10 network commands everyone should know. 

 
 Traceroute above, and: 

o Windows ⊞Start > Run > "cmd" > Enter >  tracert yoursite.com 

or Karen's Power Tools traceroute utility for Windows 

o Unix/🐧 Linux  traceroute yoursite.com 

 

 When you permanently move your website, redirect traffic from old to new location, in a 
search-engine-friendly manner, using a 301 redirect in an .htaccess file in your web server 
root.  

 
 TODO:  add Metasploit www.rapid7.com/products/metasploit and nmap www.nmap.org 

tools. 
 

Graphics/Images/Photos 
Images can be (Wikipedia article): 

 
 Lossy raster graphics image formats (uses lossy compression — destroys some info): 

o .avif (lossy and lossless, new in 2022) (and maybe .avci .avcs .avifs .heic .heics 
.heif .heifs), 

o .jpeg/JFIF, 

o .j2k/JPEG 2000 irreversible wavelet transform, 
o .heif set for lossy image data storage,  TODO:  find out how to set that (and 

maybe .avci .avcs .avif .avifs .heic .heics .heifs). 
o .pcd (viewable only via Kodak propriety viewer — covert to .jpg using 

pcdtojpeg), 

o .webp (Google). 
 Lossless raster graphics image formats (no or lossless compression): 

o .avif (lossy and lossless, new in 2022) (and maybe .avci .avcs .avifs .heic .heics 
.heif .heifs), 
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o .bmp,  
o .dng (Adobe Photoshop and Lightroom negative, extension to .tiff), 
o .flif (free lossless image format), 

o .gif,  
o .j2k/JPEG 2000 reversible wavelet transform,  

o .heif set for lossless image data storage,  TODO:  find out how to set that (and 
maybe .avci .avcs .avif .avifs .heic .heics .heifs) 

o .mng,  

o [raw] (specific to each vendor, such as .nef for Nikon or .crw .cr2 for Canon), 
o .pcx, 

o .pdf, 
o .png, 
o .psd (Adobe Photoshop's native format),  

o .svg (Scalable Vector Graphics vector-based drawings),  
o .tiff,  

o .vsd (vector-based drawings by Microsoft Visio), 
o .xaml,  
o .xcf (GIMP's native format). 

 Lossless vector-based drawings: 
o .ai (Adobe Illustrator Artwork format, vector-based, use AI, GIMP or Inkscape), 

o .eps (Adobe Illustrator format, containing both vector- and bitmap-images), 
o .vsd (vector-based drawings by Microsoft Visio). 

 

 Layered image formats: 
o .ai (Adobe Illustrator Artwork format, vector-based, use AI, GIMP or Inkscape), 

o .dng (Adobe Photoshop and Lightroom negative, extension to .tiff), 
o .eps (Adobe Illustrator format, containing both vector- and bitmap-images), 
o .gif animation frames,  

o .heif (🍎 Apple) (and maybe .avci .avcs .avif .avifs .heic .heics.heifs), 

o .pdf,  
o .psd (Adobe Photoshop's native format), 

o .svg (Scalable Vector Graphics vector-based drawings),  
o .tiff,  
o .vsd (vector-based drawings by Microsoft Visio), 

o .xaml,  
o .xcf (GIMP's native format). 

 Flat image formats:  
o .avif (new in 2022) (and maybe .avci .avcs .avifs .heic .heics .heif .heifs), 
o .bmp,  

o .eps (Adobe Illustrator format, containing both vector- and bitmap-images), 
o .gif non-animation frames,  

o .jpeg/JFIF, 
o .j2k/JPEG 2000,  
o .mng,  

o [raw] (specific to each vendor, such as .nef for Nikon or .crw .cr2 for Canon), 
o .pcd (viewable only via Kodak propriety viewer — covert to .jpg using 

pcdtojpeg), 
o .pcx,  

o .png, 

mailto:eric.piehl@gmail.com?subject=Comments%20on%20tools.doc
http://en.wikipedia.org/wiki/Vector_graphics
http://pcdtojpeg.sourceforge.net/


Piehl-14 

📱💻 </> 🛠 Computer and Programming Tools 
 

o .webp (Google). 
 
 To view images, you already have tons of options on your computer, but I like: 

o Picasa http://picasa.google.com, or its replacement Google Photos 
https://photos.google.com.  I liked Picasa much better than the photo organizer 

from my 📷 camera, and much better than Photoshop.  I should soon have an 

opinion on GP.  Review. 

 To rip or capture your screen, use: 
o [Alt-PrtScn] > then Paste into MSPaint or GIMP. 

o SnagIt. 
 To modify, retouch or author raster graphics images (photos, movies), use any one of: 

o GIMP GNU Image Manipulation Program www.gimp.org free (cropping, 
conversions, and feature “clone” work Great!) (said to have functionality similar 
to Adobe Photoshop, and is better for home users). 

 Has a function color picker.  Also a function in Microsoft PowerToys. 
 For colors, see Pantone and Freetone at 

https://hackaday.com/2022/11/16/interview-stuart-semple-on-pantone-
freetone-colour-and-open-source. 

o Markup for 🍎 Apple macOS? 

o Pixelmator for 🍎 Apple macOS? 

o MyHeritage https://myheritage.com tools, as described in 

https://wmgs.org/pdf/MyHeritage_Photo_Tools_handout.pdf : 
 Sharpen focus or blurry photos, using Photo Enhancer 

https://myheritage.com/photo-enhancer. 

 Colorize or restore color, using Color Restoration 
https://myheritage.com/incolor. 

 Animate still photos a bit, using Deep Nostalgia Animation 
https://myheritage.com/deep-nostalgia. 

 Record stories behind your favorite family photos, and attach this to your 

photo as 🔊 voiceover audio, using Photo Storyteller. 

o TODO:  Look into Canva. 
o TODO:  Look into newer versions of IrfanView. 

o Adobe Photoshop CS $$ or Photoshop Elements PSE $80 (feature “free 
transforming” allows you to knit photos or docs together into one piece, feature 
“context-sensitive clone” is said to be like GIMP clone, but you don't have to pick 

out the “from” area).  If you chose this one: 
 At install, may need to regsvr32 from %SystemRoot%\System32 and 

%SystemRoot%\SysWOW64 on %ProgramFiles%\Adobe\Adobe Premiere 
Elements [Photoshop?] 11\*.ax. 

 Before backup, copy its project files %ProgramData%\Adobe\PSE n and 

PRE n\*.psess and *.prel to somewhere in My Documents, then do the 
backup. 

 For colors, see Pantone and Freetone at 
https://hackaday.com/2022/11/16/interview-stuart-semple-on-pantone-
freetone-colour-and-open-source. 

o Adobe Photoshop Express www.photoshop.com/products/photoshopexpress 

free on Android, 🍎 Apple iOS, Windows Phone, Windows (have not yet looked at 

it). 

o TODO:  Adobe Spark on web? 
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o Overlay (filter) an image with a flag. 
o Irfan photo viewer and converter www.irfanview.com.   

TODO:  Verify has alleged screen image-grabber function.  If Yes, for quality, 

save as .tiff or .png. 
o Web-based www.fotoflexer.com. 

o Google Photos (when it was Picasa) (great for red-eye and lightening pics, and 
for face recognition).  Review. 

o Microsoft Paint MSpaint (bare-bones cropping or conversions). 

o iPhoto (🍎 Apple macOS).  How does this differ from 🍎 Apple Aperture or 

Pixelmator? 
o To resize images that look good even expanded 1,000% due to fractal 

processing, I am told that great is "Perfect Resize".  
To convert color photos to black and white, I am told great is Perfect B&W. 
These two and other utilities are bundled in Perfect Photo Suite. 

Said to have interfaces to Adobe Photoshop and 🍎 Apple Aperture. 

 Markup for 🍎 Apple macOS? 

 Pixelmator for 🍎 Apple macOS? 

 Also see Microsoft PowerToys function Image Resizer. 

o To colorize black and white photos to color, I am told there is 
https://playback.fm/colorize-photo. 

o MATLAB from MathWorks, I have heard of one person using this to process 
images. 

o To convert Kodak-propriety .pcd to .jpg, use pcdtojpeg. 
o Other image converters. 
o 13 Reasonable Alternatives to Adobe's Expensive Apps. 

 
 To draw vector graphics, including working with logos, use: 

o Microsoft Office Visio, $, Microsoft Windows.  I like it, but can get tedious. 
o Adobe Illustrator $, looks very good, incl. let trace vectors over a raster pic. 
o Adobe InDesign $, publishing and typesetting, I read is for plotters, mills and 

engravings, or for posters, flyers, brochures, magazines, newspapers, and books. 
o Adobe Photoshop $, is supposed to have some vector graphic capability. 

 For colors, see Pantone and Freetone at 
https://hackaday.com/2022/11/16/interview-stuart-semple-on-pantone-
freetone-colour-and-open-source. 

o 13 Reasonable Alternatives to Adobe's Expensive Apps. 
o TODO:  Look into Canva. 

o Inkscape, free, all platforms.  Said to be awesome on .svg, .pdf, .ai, raster, etc. 
o LibreOffice Draw, free. 

o Omingraffle on 🍎 Apple macOS. 

o Markup for 🍎 Apple macOS? 

o Pixelmator for 🍎 Apple macOS? 

o Google Drawings, free. 

o Lucidchart, free, said to be “diagramming and flowcharting software to map 
business processes, model databases, design software applications, draw IT 
networks, . . . and integrates with . . . Google Apps [later G Suite, now Google 

Workspace above] for Work, Office 365 [I hear that, as of 2020-04, MS Teams 
has been added to MS Office 365, and branded Microsoft 365], and Slack.” 

o Skills for graphic design. 
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 To design or 3D model, presumably also vector models:  

o Google SketchUp. 

o ZBrush. 
o Adobe InDesign $, publishing and typesetting, I read is for plotters, mills and 

engravings, or for posters, flyers, brochures, magazines, newspapers, and books. 
 13 Reasonable Alternatives to Adobe's Expensive Apps. 

 

 To do mass renames of files or folders (poor-man's tags), use Metamorphose 
Métamorphose 1.1.2. 

o To make things easy on yourself or buddies running Unix or Linus, or running 
any platform and using Unix or GNU utilities, I use (and recommend to all 
techies) usernames, filenames and folder names with *no* spaces 

(blanks) " ". 
o Instead use camelCase for metadata that relates to each other, perhaps 

separated by underscores "_" or hyphens "-" to metadata that doesn't relate. 
o I try to put all metadata in the filename.  For example, for photographs, I use 

format date_WhoFromTopToBottomLeftToRight_Where_doingWhat_byWhom.ext, 

where: 
 date is in ISO 8601 format, yyyymmdd (within the doc will be yyyy-

mm-dd).  The international standard, and it sorts correctly! 
 Who is in UpperCamelCase FirstLast. 
 Where is in UpperCamelCase, perhaps CityStateCountry or 

VillageCountyST. 
 doingWhat is in lowerCamelCase, perhaps atZoo. 

 byWhom is probably sometimes their initials, perhaps byEP. 
 ext is the file extension, perhaps .png. 

o Need to look into Microsoft PowerToys new function PowerRename. 

 
 [To take a cellphone mobile screenshot.] 

o Android:   hold buttons Power and VolumeDown for 3 seconds, until screen 
shrinks. 

 Windows, do one of: 

o ⊞Start > "snip" > wait > desktop app Snipping Tool > New > mouse drag 
rectangle you want > Exit > Save=Yes > to .png or .tiff format (lossless!), not 

.jpg (lossy!). 

o ⊞Win+Shift+S > choose a shape > drag your area > do something with your 

results in the Clipboard or Notification. 
  

📹 Video 
 To view all types of 📹 video and 🔊 audio sound media, including the open .ogg format: 

o If you any issues with your current media player, install VLC media player from 
VideoLAN.  I love it!  Plays all kinds of files, tolerates incomplete or damaged 
media files, records played media, converts between file types, and grabs 

individual-frame screenshots.  An article recommends that if you are also going 
to install the Irfan photo viewer and converter (described above), install 

Irfanview first, before VLC, so VLC becomes the default for all media files. 
 To save videos from Facebook. 
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 To rip YouTube videos (and some other Flash video streams) into video files on your 
harddrive: 

o As of 2018-02-19 and 2021-02-19, OK seems to be http://www.clipconverter.cc 

> remember and follow the instructions listed there > exit the new tab of 
advertising that it opens. 

Download as .avi or .mp4. 
 Downloading 1080p in format .mp4 showed great in VLC media player, but 

was very-jerky playing in MS PowerPoint 2010. 

 Downloading 720p in format .mp4 or.avi played very well in PP 2010. 
 Downloading 720p in format .mov, and .mp4 or.avi, were also very-jerky 

playing in PP 2010. 
 Downloading 720p in format .wmv was not Insertable into PP 2010. 
 If this website works for you, do not try any of the following . . . 

o www.computerhope.com/issues/ch001002.htm has lots of suggestions.  The only 
one that works on my locked-down system (and then only in IE) is 

www.keepvid.com > at bottom of page, turn on "Java ", "Show Log " and "Show 
Sizes (MB) " > Paste into text box at top your YouTube or other URL > click top-
right button "Download" (middle button "Download" is an ad, I think) > wait a 

bit > let Java app KeepVidDownloader from http://keepvid.com Run > I have 
been using Download MP4 (Max 480P) to good effect. 

o https://github.com/rg3/youtube-dl works, but puts on Trojan: 
Win32/Tefau.A!cl, so if you must use this software, run a full antivirus scan!  

o Do not use this:  contains difficult-to-remove malware:  YouTube Downloader 

YTD.  (On 2013-02-03, this failed, unless I reformatted 
www.youtube.com/watch?v=11chacterID to http://youtu.be/11chacterID or to 

http://youtu.be/11chacterID?hd=1, but I haven't seen this problem in a while.) 
 If YTD saved the file as a .mp4, and you are going to use it in Adobe 

Photoshop Elements PSE 11 slideshow, it will crash PSE.  Installing 

Adobe Premiere Elements PRE 11 helped PSE to not crash on .mov files.  
But still, PSE 11 crashes on .mp4 and .3gp files.  Finally found a help 

page about slideshows needing to be photos or .pse or .wmv.  Use YTD to 
convert the .mp4 download to .avi (9% larger, but better frame rate) or 

.wmv format, then use that in your PSE slideshow. 
 To download non-video files (never download a .dll–don't do it!): 

o TODO:  try www.computerhope.com/issues/ch001002.htm. 

o Paste your URL into www.downloadbyurl.com.  Seems to be bad now. 
 To rip a DVD using VLC.  Or trim or convert videos using VLC or Clipchamp. 

o I find .mpg files to be this highest quality.  Not bad. 
o If you are going to use in PowerPoint 2010, and PP doesn't like that: 

 Convert it to an .mp4 file, using codec H.264.  Less quality than above, 

but not terrible. 
 Do not convert it to an .mp4 file, using codec H.265.  Very jumpy;  

pretty terrible. 
 Convert to an .avi  or .wmv file? 

 To create video animations, I am told Adobe After Effects is good. 

o 13 Reasonable Alternatives to Adobe's Expensive Apps. 

 To edit video, I am told Magix Movie Edit Pro Plus, and 🍎 Apple Final Cut Pro X and 

Compressor (macOS, apparently) are good.   

And of course, Adobe Premiere Pro ($$), and Adobe Premiere Rush or Premiere 
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Elements PRE ($).  Help https://youtu.be/TEAnYKgvPxg.  (13 Reasonable Alternatives to 
Adobe's Expensive Apps.) 

And 🍎 Apple iMovie (for macOS) (and Screenflow for 🍎 Apple macOS?) and iMovie for 

iOS (and presumably for iMovie for iPadOS). 

Need to look into VideoLAN Movie Creator VLMC https://videolan.org/vlmc. 
To trim (video for crop-in-time): 

o Adobe Premiere Elements PRE ($) (three different ways) (my favorite is by 

launching Adobe Premiere Elements PRE 11 > button "Video Editor" > button 
"New Project" > top navigation bar "Quick" > drop your input file into button 

"Drop Files Here" > ▶ Play until right part [if you wish, zoom the timeline using 
the lower right Render zoom slider] > Pause or slide the red you-are-here 

timeline until you get to the right spot > mouse to the red you-are-here timeline 
until you see a button with scissors icon > click that scissors button > for each 
part you don't want to use, right-click it "Delete and close gap" > repeat this for 

anything else you need to do.  When you are happy, "File" > "Save" or "Save As" 
the project file to location and name you wish > upper-right button 

"Publish+Share" > "Computer" > "AVCHD" > something compatible with frame 
rate of the original, such as "MP4 - H264 1440x1080p 30" [.mp4] [launches in 
WMP] [good quality] > file name and location for your movie > "Save"), or 

 13 Reasonable Alternatives to Adobe's Expensive Apps. 

o VLC > View > Advanced controls > ▶ Play pause frame-by-frame > Record, find 

in "file:///C:/Users/yourUserName/Videos", or 
o Windows Live Movie Maker, but it is lossy (changed .mpg to .wmv, to half 

size, from 720x480 x 224 kbps to 640x480 x 128k), or 
o www.solveigmm.com/en/products/avi-trimmer-mkv and doc 

www.solveigmm.com/files/USG_AVITrimmer.pdf.  

SolveigMM_WMP_Trimmer_Plugin_2_1_1111_8.exe  > Windows Media Player > 
Tools->Plug-ins->SolveigMM WMP Trimmer Plugin. 

 YouTube: 
o Upload via https://youtube.com/upload. 
o More details at www.ericpiehl.com/present.pdf#page=20 section "Upload video 

to YouTube". 
 YouTube video URLs: 

o ! https://youtube.com/embed/8cRrjJCgRcQ  ▶ Play > ⛶ fullscreen, shorter URL 

o ! https://www.youtube.com/embed/8cRrjJCgRcQ  ▶ Play > ⛶ fullscreen. 

 "For full effect, select the video link, then icons ⛶ fullscreen, ㏄ captions, 

▶ Play, and ⛶ ☒ Skip Ads." 

o https://youtu.be/4AjzTcavoYw  ordinary viewer, shortest URL 

o https://youtube.com/watch?v=4AjzTcavoYw  ordinary viewer, shorter URL 
o https://www.youtube.com/watch?v=4AjzTcavoYw  ordinary viewer, full URL 

o www.youtube.com/watch?&v=4AjzTcavoYw  what I was using in docs 
o There are additional parameters for autoplay, start at a particular time, etc. 

https://youtu.be/RzzWmTIVv3c?t=37m36s ordinary viewer, at a particular time 
https://youtube.com/embed/8cRrjJCgRcQ?rel=0&amp;autoplay=1;fs=0;autohide
=0;hd=0 

https://youtube.com/embed/8cRrjJCgRcQ?cc_load_policy=1 
https://www.youtube.com/embed/8cRrjJCgRcQ?yt:cc=on   

https://www.youtube.com/embed/8cRrjJCgRcQ?yt%3Acc=on 
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 “Library of millions of free books, movies, software, music,” and website Wayback 

Machine (not the same as 🍎 Apple Time Machine) at the Internet Archive. 

 Free movie streaming. 

 📹 Video converters. 

 To record your screen (🍎 Apple, Android, ⊞ Windows) into a video file. 

 How to Record Phone Calls on your iPhone or Android. 

 

🔊 Audio/Sound 
 Radio. 

 To communicate via voice over VoIP:  Skype or WhatsApp or Google Hangouts. 

 To play all types of 🔊 audio sound and 📹 video files, including the open .ogg format, 

o I use iTunes for almost everything, mostly because of downloading free 
podcasts. 

o If you any issues with your current media player, install VLC media player from 
VideoLAN.  I love it!  Plays all kinds of files, tolerates incomplete or damaged 

media files, records played media, converts between file types, and grabs 
individual-frame screenshots.  An article recommends that if you are also going 
to install the Irfan photo viewer and converter (described above), install 

Irfanview first, before VLC, so VLC becomes the default for all media files. 
o One article suggests Jaangle. 

o Other file extensions are .mp3, .wma, .flac, .ape, .aac (🍎 Apple iTunes), .acc 

(🍎 Apple) and .acelp (for speech). 

o TODO:  Look up which formats are lossless or high quality. 

 For royalty-free 🔊 audio files, see Partners in Rhyme.  Some tracks are free. 

 “Library of millions of free books, movies, software, music,” and website Wayback 

Machine (not the same as 🍎 Apple Time Machine) at the Internet Archive. 

 To rip streaming audio Flash to your harddrive, howto. 

 To download, Paste your URL into www.downloadbyurl.com.  Seems to be bad now. 

 To record and edit 🔊 audio sounds, including trim (crop): 

o Cross-platform, Audacity 1.3.13, free.  [2021-07:  now considered malware.  
The old Audacity is being resurrected as Tenacity or Sneedacity.] 

o On 🍎 Apple iOS (and presumably for iPadOS), use app Voice Memos. 

 How to Record Phone Calls on your iPhone or Android. 

 🔊 Audio converters. 

 

 To rip audio CDs to 🔊 audio files onto your harddrive: 

o See folder file:///C:\Users\EricPiehl\Documents\Tools\VLC\, and tailor file 

"Follett_WorldWithoutEnd_VLC_CD_RIP.bat". 

o Can run it with ⊞Win+X (or right-click of ⊞Start icon) > Windows 

PowerShell (Admin) or Command Prompt (Admin) > type: 
 "cd C:\Users\EricPiehl\Documents\Tools\VLC\" (no quotes) [Enter], 
 ".\ Gawande_BeingMortal_VLC_CD_RIP.bat". 

o You probably want to move your new files 
 from file:///c:\Users\EricPiehl\Music\VLC_CD_RIP \author\title 

 to file:///c:\Users\EricPiehl\Music\iTunes\iTunes%20Media \author_title, 
 and then to a flash-drive/jumpdrive/thumbdrive/USB-drive/USB-

key/ USB-stick to put in the car. 

mailto:eric.piehl@gmail.com?subject=Comments%20on%20tools.doc
https://archive.org/
https://www.lifewire.com/watch-free-movies-online-1356647
https://www.lifewire.com/free-file-converter-software-and-online-services-2626121
https://www.lifewire.com/record-your-screen-on-any-device-4151716
https://www.lifewire.com/record-phone-calls-iphone-or-android-4129175
https://www.lifewire.com/top-fifty-useful-sites-3481693
https://www.videolan.org/
https://www.videolan.org/
http://www.partnersinrhyme.com/soundfx/animals/WhalesDolphinsSeal.shtml
https://archive.org/
http://www.youtube.com/watch?v=AajfPk7Nosk
http://www.downloadbyurl.com/
http://audacity.sourceforge.net/
https://www.lifewire.com/record-voice-memos-on-iphone-4148265
https://www.lifewire.com/record-phone-calls-iphone-or-android-4129175
https://www.lifewire.com/free-file-converter-software-and-online-services-2626121
file:///C:/Users/EricPiehl/Documents/Tools/VLC/
file:///c:/Users/EricPiehl/Music/VLC_CD_RIP
file:///c:/Users/EricPiehl/Music/iTunes/iTunes%20Media


Piehl-20 

📱💻 </> 🛠 Computer and Programming Tools 
 

 

 To rip YouTube videos to 🔊 audio files onto your harddrive: 

o https://www.youtube5s.com/watch?v=___________ > dropdown to MP3 
128kbps > button Get Link > right-click button Download > Open in New 

tab > Save File > if any popups, exit them > wait for .mp3 file to show up in 
the folder your browser uses for Downloads. 

o Launch computer app VLC >  

 action bar Media > Open Network Stream ... > tab Network > URL for 
your video file (e.g., https://www.youtube.com/watch?v=___________ ) 

> [if way longer than you need, check checkbox Show more options > 
give it a starting and ending time >] button Play > after it starts > 

 action bar Tools > Codec Information > copy Location > stop the 
video > 

 action bar Media > Open Network Stream > tab Network > Paste the 

long URL you copied above > dropdown Play > Convert [Stream > 
button Next > button Add file > ] > Audio - MP3 > give it a destination 

folder (e.g., file:///C:\Users\EricPiehl\Downloads\) and filename (e.g., 
___________.mp3 ) > [if way longer than you need, check checkbox 
Show more options > give it a starting and ending time >] button Save 

> 
 button Start > wait for file to be converted > do something with the file.  

 2022-01-20 haven't been able to get this to work, on 
https://www.youtube.com/watch?v=CMSIMrCynyg into https://rr5---sn-
vgqsknld.googlevideo.com/videoplayback?expire=1642739401&ei=aOLpYb

faN4b0igS8ub2oCA&ip=2601%3A404%3Ace00%3A150b%3A706b%3Af30
7%3Adefc%3A85cd&id=o-ANb3c-

g3AoxSZeQCKjD91spXAkE7SSmMYzK0InqYXMiY&itag=22&source=youtub
e&requiressl=yes&mh=dv&mm=31%2C26&mn=sn-vgqsknld%2Csn-
p5qlsndk&ms=au%2Conr&mv=m&mvi=5&pl=34&initcwndbps=1507500&v

prv=1&mime=video%2Fmp4&ns=LzDSWreqgfVhL8aH468R9nEG&ratebypa
ss=yes&dur=1217.190&lmt=1619902984140078&mt=1642717514&fvip=

5&fexp=24001373%2C24007246&c=WEB&txp=5311224&n=opTKyM5ag8
MrtSwch0PU&sparams=expire%2Cei%2Cip%2Cid%2Citag%2Csource%2Cr
equiressl%2Cvprv%2Cmime%2Cns%2Cratebypass%2Cdur%2Clmt&sig=A

Oq0QJ8wRQIhAOVJKGB_zX0bnRP52Ni5YjiW0zBTQo1pGwYbgZ99-
h00AiA1aiQeZQwBUpB2aZVCs1hVta_-

_9tfeq9yACMX5G3fqQ%3D%3D&lsparams=mh%2Cmm%2Cmn%2Cms%2
Cmv%2Cmvi%2Cpl%2Cinitcwndbps&lsig=AG3C_xAwRgIhAIhAFDLCkPjrcLj
jBfVmCftfpTpiWT5MqLktf2x53leiAiEA2XHatiYrPYIiEh6AU3TexQYf7NLSbdD5

MQouO5L64TM%3D into 
file:///C:\Users\EricPiehl\Downloads\CMSIMrCynyg.mp3  — https://online-

tech-tips.com/google-softwaretips/how-to-rip-audio-from-youtube. 
o VLC > Convert / Save ... > tab Network > Add > URL for your video file > 

dropdown Convert / Save > Audio – MP3 > give it a destination folder and 

filename > button Start.  As of 2022-01-19, creates 0-length file. 
o https://video.genyoutube.net /VamQSEW7KAw.  (As of 2022-01-19, broken.) 

o https://mp3-convert.org/  (As of 2022-01-19, horrible ads.) 
 

 My local library, has a Podcast Studio (only 1 reservation allowed per day), with: 

mailto:eric.piehl@gmail.com?subject=Comments%20on%20tools.doc
https://www.youtube5s.com/watch?v=___________
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o A soundproof room with a Internet, phone, table, 4 chairs, instructions,  

o Three 🎤🔊 professional microphones and closed-back headphones, connected to a ... 

o RØDECaster Pro audio mixing console (mixing board) 
https://rode.com/rodecasterpro, which can store audio recordings on a microSD (μSD 

microSDHC microSDXC microSDUC TF) card, and optionally transmit it over a USB-
A/USB-C cable to a ... 

o laptop running ... 
o RØDECaster Pro Podcast Studio software (to configure something, and one way to get 

your recording off the mixing board), and 

o Adobe Audition 2020 software (to edit your 🔊 audio recording or podcast). 

 13 Reasonable Alternatives to Adobe's Expensive Apps. 
o Instructions and signup are at https://kdl.org/podcast.  Under the COVID-19 

coronavirus pandemic, they only allow one signup per day, so you might as well reserve 
it all day!  Hours https://kdl.org/locations/ADA.  Questions "Penni Zurgable 
(PZurgable@kdl.org)". 

o I made a test audio recording and transferred it to my computer.  Way cool! 
o Need to verify that I can fix soft recording level, by adjusting mixer board's Output-

level slider. 

o Need to determine how to feed podcast studio's 🔊 good audio into a Zoom 

presentation, or a 📹 video recording of someone showing and doing stuff on a 

computer.  Presumably from the mixer's Audio Outs, into a computer, using some 
combination of cables and connectors. 

o May practice editing an 🔊 audio recording using podcast studio's Adobe Audition 

2020 software. 
 13 Reasonable Alternatives to Adobe's Expensive Apps. 

 Need to determine a way to,  

  while people are waiting for a Zoom presentation to start,  
  while sharing a nice slide with the name and subject of the presentation and that it will 

start soon, 
  have neither silence nor the panelists talking among themselves,  

  but have some 🔊 music or nature sounds, 

  so that people know their 🔊 audio is working. 

This is regardless of using a podcast studio or not. 

This ought to work, but it doesn't:  On slide-sharing computer > launch presentation with 
intro slide with the name and subject of the presentation and that the presentation will 

start soon > launch audio > launch Zoom > button "Share Screen" > check checkbox 
"Share sound" > select the window with the intro slide > button "Share" > verify slide and 
audio are visible and audible over Zoom.  The slide is visible, but the audio is not.  Does the 

audio have to be embedded in the slide? 
 

</> Web development 
 Static website generators: 

o I wrote my own!  Which I use for icanseenature.com and ericpiehl.com. 
 

 Website builders (free). 
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 HTML editor, WYSIWYG, www.wikipedia.org/wiki/KompoZer version 0.7.10, said to be 
more reliably maintained than Nvu. 
o When is this going to support HTML 5? 

o font type guide 
 

 HTML validator program www.wikipedia.org/wiki/HTML_Tidy (set to XHTML 1.0 
Transitional) (this is extremely useful), or use http://validator.w3.org/ (examples in 
ICSN). 

 
 Google's: 

o website validator Search Console https://google.com/webmasters/tools/home, 
including https://google.com/webmasters/tools/mobile-friendly (examples in ICSN) 

o resources for hacked sites https://www.google.com/webmasters/hacked/ 

o other steps on "This site may be hacked". 
 

 Firefox add-ons Firebug and Web Developer (add to the other add-ons I recommend:  
Adblock Plus, ChromaTabs Plus, Dafizilla, IE Tab, Html Validator above, HTTPS Everywhere, 
and McAfee SiteAdvisor). 

 
 Chrome is way faster than Firefox 3 (as of 2011-01-11).  TODO:  if you can stand the 

thought of having three browsers on your machine, try Chrome v. Firefox again now that 
Firefox 4 is out.  After a little learning curve, I like Chrome a lot, and use it as my primary 
Browser. 

o I hear that add-ons FlashBlock and AdBlock are good. 
o I hear that add-ons IETab, Stayfocusd and Feedly are good;  I have them, but 

are currently Disabled.  I have Google Calendar Checker extension turned on. 
o No (little?) need for the Firefox add-on Firebug, with equivalent (?) functionality 

built into Chrome, on page of interest > right-click Inspect Element (or Ctrl-Shift-

I or click wrench icon > Tools > Developer tools) (see other cool tools under the 
wrench icon).  Karl Swedberg wrote, “Firebug was one of the few things keeping 

me using Firefox rather than Chrome, but the pace of improvements to the 
Chrome Dev Tools has been amazing.  I like a number of the features in Chrome 

Dev Tools much more than similar ones in Firebug now.  Definitely run Chrome 
from at least the Dev channel to get all the good stuff.  Paul Irish has a couple 
great videos (1 , 2) that show some of the cool stuff you can do”.  I have done 

this, looks good.  TODO:  finish watching those two videos. 
o If you use Chrome, you may need to use chrome:about, chrome:plugins, 

chrome:extensions, chrome:settings/passwords and chrome:settings/content.  
o For all web browsers, consider testing your browser against tracking, and 

installing plug-ins: 

 HTTPS Everywhere from the EFF, protecting you against eavesdropping, 
tampering with or forging content in more of the websites you visit.  So 

far, trouble-free for me. 
 Privacy Badger new from the EFF (good, but I have to tell it to exclude 

some websites), or 

 www.ghostery.com> set to block web tracking types Advertising, 
Analytics, Beacons, Privacy and Widgets.  A cousin recommended this.  I 

am experimenting with this, currently with everything blocked except for 
one Analytics that I use occasionally.  So far, so good. 
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o Users on a 💻 computer with default browser Firefox, Edge, Safari, Opera, 

Vivaldi or Brave? 

 
 Android Google Docs app, including taking photo of doc > converted into text. 

  

 Optional (I have not used this yet, but recommended by the Sierra Club webmastering 
listserv) Cascading Stylesheet CSS Validator http://jigsaw.w3.org/css-validator/. 

  
 Optional (I have not used this yet, but recommended by the Sierra Club webmastering 

listserv) JavaScript Validator www.jslint.com. 
 
 “Library of millions of free books, movies, software, music,” and website Wayback 

Machine (not the same as 🍎 Apple Time Machine) at the Internet Archive. 

 

Database 
 MySQL.  Used it for a class, love it, easy to use, all platforms. 

 Microsoft SQL Server.  Used this at two workplaces, very capable, full function.  $, 

Microsoft ⊞ Windows only. 

 FileMaker Pro.  Looks awesome, on 🍎 Apple macOS. 

 

mailto:eric.piehl@gmail.com?subject=Comments%20on%20tools.doc
http://jigsaw.w3.org/css-validator/
http://www.jslint.com/
https://archive.org/
http://ericpiehl.altervista.org/ApacheMySqlPhp.doc


Piehl-24 

📱💻 </> 🛠 Computer and Programming Tools 
 

File management 
 When you acquire a new flash-drive/jumpdrive/thumbdrive/USB-drive/USB-key/ 

USB-stick: 

o IF your drive came in format="FAT32",  
   AND you want your drive to handle file sizes >4GB=No,  
THEN you can leave it just like this. 

o IF your drive came in format="NTFS",  
   AND you want your drive for Microsoft Windows use=Read-Write  

   AND 🍎 Apple macOS use=Read-Only or not at all,  

THEN you can leave it just like this. 
o IF your drive came in format="HFS+",  

   AND you want your drive for 🍎 Apple macOS use=Read-Write  

   AND Microsoft Windows use=not at all,  
THEN you can leave it just like this. 

o IF you want your drive for use in the Honda Fit/Jazz Type 2 entertainment 

system,  
THEN reformat your drive to format="FAT32". 

o IF you are running 🍎 Apple macOS level lower than 10.6.6, 

THEN apply the "exFAT patch". 

o IF you are running Microsoft Windows release lower than 7, 
THEN apply the "exFAT patch". 

o IF you are running Microsoft Windows release lower than 10, 
THEN upgrade to a modern level of Windows with all due speed. 

o IF you want your drive for 🍎 Apple macOS use=Read-Write  

   AND Microsoft Windows use=Read-Write,  
   AND handle file sizes >4GB=Yes,  
THEN reformat your drive to format="exFAT" as in 
https://support.wdc.com/knowledgebase/answer.aspx?ID=291 (creates folder 

"__MACOSX"). 
 While you are at it, personalize the name of your backup drive to: 

o something with your name and location, in format FirstLastUSA, or 

o a permanently-available 📱☎ phone number, in format AAA-EEE-NNNN. 

 
 To get Microsoft Windows My PC/File Explorer (formerly My Computer/Windows 

Explorer, and still called "Windows Explorer" under-the-covers) to sort Folders on top, 

https://duckduckgo.com/?q=windows+10+sort+folders+top or 
https://google.com/search?q=windows+sort+folders+top said to: 

o View > Details (OK, I run that way),  
o then sort column Date Modified to V (OK, I run that way),  
o then Shift-click column Name.  Worked.  Weird. 

 To get the other File Explorer (formerly Windows Explorer, and still called "Windows 
Explorer" under-the-covers) from Microsoft, see the Microsoft App Store 

https://microsoft.com/store/apps/windows > search "Files".  Not yet sure if better. 
 
 To share folders or files with yourself or a distributed workgroup collaboration, use 

Dropbox (Basic plan FREE) (I love this, and use all the time!), Box, Microsoft OneDrive, 🍎 

Apple iCloud, Google Drive (review), pCloud;  or the more-secure milDrive, sync.com 
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or SpiderOak ONE ($);  or other file hosting, file synchronization, or online backup 
services. 
Or use the collaboration features of Google Drive and Microsoft OneDrive. 

o If you have an Outlook.com/Live Mail (formerly Hotmail) email account, you 
already have access to Microsoft OneDrive and Office Online through your 

email account.   

o If you have 🍎 Apple devices, you probably already have access to iCloud.   

o If you have a Gmail email account, you already have access to Google Docs, 
Sheets and Slides through your email account. 

 

 In Android, use ES File Explorer. 
 
 When scanning into a .pdf, do so using OCR to make it searchable/copyable/ 

pasteable!   
o My Canon Pixma MX922 printer does a nice job, if I: 

 (One-time) Have previously: 
 Installed on my computer Canon IJ Scan Utility (this is what you 

will use two bullets down). 
 Installed on my computer Canon My Image Garden 

(unfortunately, the OCR software resides in this otherwise-useless 

piece of software). 
 Rebooted. 

 Optionally uninstalled Canon My Image Garden Design Files. 
o Do not uninstall plain Canon My Image Garden 

(unfortunately, the OCR software resides in this otherwise-

useless piece of software). 

 Brought up my computer's ⊞Start > Canon Utilities > IJ Scan 

Utility > button [gear] Settings > left tab Set the preferences 
for scans that are started from the computer > tab Document 

Scan > section Save Settings > set dropdown Data Format: to 
PDF or PDF (Multiple Pages) > button [gear] Settings… > 
check checkbox Save a PDF that supports keyword search > 

button OK > button OK.  

 Brought up my computer's ⊞Start > Canon Utilities > IJ Scan 

Utility > button [gear] Settings > left tab Set the preferences 
for scans that are started from the buttons on the printer or 
scanner > tab Save to PC (Document) > section Save Settings 

> button [gear] Settings… > check checkbox Save a PDF that 
supports keyword search > button OK > button OK.  

 (Each time) Do the scan from my computer's ⊞Start > Canon Utilities > 
IJ Scan Utility > button Document.  Even though I have done the last 

bullet above, I still avoid doing the scan from the printer's control panel.  
o I have not yet used these, but I read that you can after-the-fact add OCR 

searchable/copyable/pasteable text using: 

 Irfan photo viewer and converter www.irfanview.com, 
 Adobe Acrobat ($$, not Reader), 

 13 Reasonable Alternatives to Adobe's Expensive Apps 
 ABBYY Fine Reader, 
 FreeOCR or 
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 tesseract. 
 OmniPage, 
 FineReader or 

 Readiris. 
 

 Zip program 7-Zip 7-zip.org.  Best I have seen.  Does all formats (including Unix-format 
.tar, .bzip2 and .tgz), very large files, encryption, is bulletproof and easy to use. 

 

 To convert files: 
o General-purpose converter, recommended to me, but I have not used it yet. 

o General-purpose converter, I have not used it yet. 
o List of file converters, I have not yet used them. 
o 2EPUB is online converter to make eBook e-reader files in formats .epub, .fb2, 

.lit, .lrf, .mobi from .doc, .epub, .fb2, .html, .mobi, .pdf, .prc, .rtf, .txt. 
 .pages, .numbers, .key ? 

o Tools to sign and edit .PDFs. 
o convertii and Nitro Cloud (free) and PrimoPDF and PDF Online convert to .doc, 

.ppt, .txt, .xls files from .pdf scans (for searchable/copyable/pasteable, see two 

major-bullets above). 
 .pages, .numbers, .key ? 

o Google Drive (review) makes editable text from .pdf via Upload > "Convert text 
from PDF and image files to Google documents." 

o Other file converters. 

 
 Compare folders and files utility (you need one to keep the various versions of stuff 

straight!): 
o Beyond Compare (my favorite!) or               TODO: expand on this. 
o WinMerge (works fine, but is clunker than above) or 

o Total Commander (I haven't used it, but a guy I trust likes it, it seems to have 
file management functions, too) or 

o Compare feature in your editor, such as UltraEdit or SlickEdit. 
o These are good ways to enforce your folder and file naming conventions. 

 
 CCleaner [except in 2021, is identified by Microsoft Defender Antivirus as a PUP 

Potentially-Unwanted Program, and may recently be crapware] > Tools > Duplicate 

Finder seems to be adequate at cleaning up from projects that you completed quickly, but 
left files splattered all over.  It does this by finding, showing, and optionally deleting these 

files. 
 But I like Auslogics duplicate file finder a little better.  But to keep out bloatware, during 

the install: 

o select radio button "Custom install (advanced)", and  
o uncheck every checkbox.     TODO:  Suggest a Rename function. 

 
 Verify file integrity of downloads using SHA1 or MD5.  Actually, they should use SHA2. 

 

 Since Microsoft Windows 7 has made defrag difficult to control, and impossible to get it to 
do anything nor see what it is doing, I installed Auslogics disk defrag.  I run it monthly or 

so, to defrag my disk anyway.  I am very happy with it.  But to keep out bloatware, during 
the install: 

o select radio button "Custom install (advanced)", and  
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o uncheck every checkbox. 
 
 FTP fat clients: 

o WS_FTP95LE (love it--have used it for years!), 
o open-source free FileZilla (I have used FileZilla, but have no opinion of it--must 

have worked fine) (but watch out for it asking to install other software [tell it 
No], and installing other software without asking, such as Web Companion 
[reboot and uninstall it]!), or 

o SmartFTP. 
 

 To burn bootable CDs or bootable DVDs from ISO images (like your Rescue CD): 
o On Win 7 or above, you can use Windows. 
o On Windows pre-7, use ImgBurn  (when installing, use Advanced and uncheck 

bloatware checkboxes) or IsoBurn (both work great). 
 To copy bootable CDs or bootable DVDs (like your Rescue CD), use ImgBurn (when 

installing, use Advanced and uncheck bloatware checkboxes). 
 Regarding bootable Recue CDs, create some!  I have used Knoppix to great effect several 

times, F-Secure bootable CD antivirus CD to good effect once, and BartPE. 

 You can create bootable USB drives, too.  I did it once, using instructions on the Internet 
somewhere.  Maybe described above in the Troubleshooting section. 

 
 To the Windows My PC/File Explorer (formerly My Computer/Windows Explorer, and 

still called "Windows Explorer" under-the-covers) context menu, temporarily add the 

complete filename path with Shift-right-click > Copy as Path.  Annoying that you have to 
hold down the Shift key, but has not yet annoyed me enough to hack the Registry. 

 
 To do mass renames of files or folders (poor-man's tags), use Metamorphose 

Métamorphose 1.1.2. 

o To make things easy on yourself or buddies running macOS or Unix, or running 
any platform and using Unix or GNU utilities, I use (and highly-recommend) 

usernames, filenames and foldernames with *no* spaces (blanks) " ". 
o Instead use camelCase for metadata that relates to each other, perhaps 

separated by underscores "_" or hyphens "-" to metadata that doesn't relate. 
o I try to put all metadata in the filename.  For example, for photographs, I use 

format date_WhoFromTopToBottomLeftToRight_Where_doingWhat_byWhom.ext, 

where: 
 date is in ISO 8601 format, yyyymmdd (within the doc will be yyyy-

mm-dd).  The international standard, and it sorts correctly! 
 Who is in UpperCamelCase FirstLast. 
 Where is in UpperCamelCase, perhaps CityStateCountry or 

VillageCountyST. 
 doingWhat is in lowerCamelCase, perhaps atZoo. 

 byWhom is probably sometimes their initials, perhaps byEP. 
 ext is the file extension, perhaps .png. 

 

 Source code management/revision control system  
You are going to use one in industry, so you might as start getting used to it now. 

At work, I have used 5 different systems at work, most purchased, one homegrown (which 
a pair of us enhanced to do parallel development).  At home, I installed SVN and 
TortoiseSVN for a class, but had to get homework done before getting it fully configured.  I 
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have not yet used the others.  TODO: talk about distributed systems:  Git or Mercurial.  
Say something nice about Git. 
 

Git  “The biggest advantage I've seen to git over subversion, besides the ‘local branch' 
effect, is the merging tools are wayyy better.  Ridiculously better.”   --Matt Heusser of 

GRJUG. 
 
Mercurial open-source cross-platform distributed revision control tool.  Good tutorial. 

 
Subversion SVN. 

o Apache Subversion binaries 
http://subversion.apache.org/packages.html#windows;  works great. 

o Optional, can use www.github.org for SVN subversion source repository. 

o If Windows, the Windows My PC/File Explorer (formerly My 
Computer/Windows Explorer, and still called "Windows Explorer" under-the-

covers) interface to Subversion TortoiseSVN www.tortoisesvn.net 1.5.7 has nice 

instructions for installing SVN, at ⊞Start > [All] Programs > TortoiseSVN > Help. 

o If you want your own SVN (good idea), and after installing TortioiseSVN and 
reading its nice instructions: 

 Automated (installer was nice, but where are all the files, and why do they 

not seem to be hooked up to anything?): 
 Python Windows installer www.python.org version 2.5.4 (why 

doesn't SVN recognize 2.6.1 or 3.0.1?). 
 SVN from http://subversion.tigris.org/ > binaries > your Apache 

version > “Python 2.5 bindings installer for Win32” version 1.5.5. 

 Manual: 
 Subversive subversion for Eclipse 

http://www.eclipse.org/subversive/. 
 SVN from http://subversion.tigris.org/ > binaries > your Apache 

version > “Subversion Win32 [if you run WinDoze] binaries [if you 

don't need source] for Apache 2.2.x (2.2.9 or higher is required 
within the 2.2.x series)” version 1.5.5. 

 Looks good, but how do I install it? 
o Unzip yourself (use 7-Zip below if needed). 
o Move from your trash location to C:\Program 

Files\Subversion. 

o Follow nice instructions for installing SVN, at ⊞Start > [All] 

Programs > TortoiseSVN > Help > section “Setting Up A 
Server”. 

 Using SVN: 
www.cis.gvsu.edu/~adams/Scholarship/subversionTutorial.html and 
http://svnbook.red-bean.com/ esp Chapter 2.  But I still don't know how 

to do that. 
http://svnbook.red-bean.com/ book 

 
After installing your source code management/revision control system, put in a 
daily/continuous auto-build/auto-test (continuous integration) server.  

Seriously.  Save yourself tons of hours and hassle.  Do it.  And check your 
dashboard every morning when you come in.  Or put a stoplight over the middle of 
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your development area, showing red/yellow/green with the results of the latest auto-
build/auto-test cycle.  Be amazed at how quick and easy it is to solve problems 
when you catch them within hours, rather than months, of when someone “broke the 

build.”  Then, to your source-code-check-in or daily-build process, add static code 
analysis.  Hold your team accountable that no project may be considered done until it 

is (1) checked in, (2) passed static code analysis, (3) passed an auto-build cycle, 
and (4) passed an auto-test cycle.  Despite initial resistance, be amazed at how 
quickly your team learns to appreciate that once their code goes in good, it stays good. 

 
 “Library of millions of free books, movies, software, music,” and website Wayback 

Machine (not the same as 🍎 Apple Time Machine) at the Internet Archive. 

 

Testing 
 TODO:  Play with free unit testing tools NUnit, JUnit, others from the xUnit series, and 

Embedded Unity Embunity (written by the cool people at Atomic Object), from SourceForge. 

 TODO:  Look in detail at Hans Schaefer's list of software testing tools. 
 TODO:  Suggest that Ruby programmers use RSpec. 

 TODO:  Copy Test-Driven Design TDD stuff from other source, including new stuff. 
 
 Article “Meaningful and Flexible Survivability Assessments:  Approach and Practice”: 

o Software systems test should cover not only functionality and performance, but 
also Confidentiality, Integrity and Availability CIA (security). 

o Has a nice chart of non-functional tests. 
o Talks about “test attacks,” vulnerabilities, and survivability testing, including TCP 

connection flooding, serialization attacks, password cracking, malformed XML, 

SQL injection (!). 
o They use open-source tools: 

 Static code analysis.  Looks for faults/errors/bugs before a failure can 
occur at run-time, before raising an incident.  I agree.  After trying out 
these tools offline, you will be shocked that your current code base ever 

worked.  Fix these problems, then put tool in your source-code-check-in or 
daily-build process so similar problems never come back: 

 C, C++, Perl, PHP, Python Rough Auditing Tool for Security 
RATS. 

 C, C++ FlawFinder. 

 Java byte code FindBugs.   
Javatester, including a nice tester of which Java version your 

browser is using.  
Another Java tester.  Old Java version uninstall tool. 

 More static code analysis tools 
 Execution analysis (memory leaks, memory corruption, memory 

profiling tools): 

 C++ Valgrind. 
 C or C++ pointer checking Mudflap. 

 C or C++ mpatrol. 
o Other tools from www.forge.mil ? 

 

 "Test what you fly, fly what you test!" (The way I learned it writing aviation software.) 
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o We almost caused Apollo 11 moon mission to abort!  
o Mars and other “Loss of Mission” failures (also see later pages) 

 "Train like you fight;  fight like you train." (The way I heard some of our users learned it.) 

 "Plan your work;  work the plan."    (The way I learned it in chainsaw safety training) 
 Ariane 5 Flight 501 Failure (US$370 million loss, delayed program 17 months). 

 GAO Report: Patriot Missile Defense — Software Problem Led to System Failure at Dhahran, 
Saudi Arabia (28 dead, system laughed at). 

 Radiation and other “History's Worst Software Bugs”. 

 “Toyota Case: Single Bit Flip That Killed” and design and transcript. 
 

Project management and collaboration software 
 Microsoft Project.  Very useful for multi-person projects.  But a lot of work to get your 

project in, broken up into tasks and allocated to resources, and kept up-to-date.  Not sure 
anyone else could do better — may just be the nature of the beast.  Would love to see a 

side-by-side fly-off. 
 Look for Kanban software, like Trello, in this comparison of project management 

software.  Like Kanban a lot, but have only used with sticky-notes on a wall.  Would love 
to see if software is any good.  For personal use, and for multi-person projects. 

 See also this comparison of collaborative software. 

 See also some notes in this document's sections Editors (doc) and File management. 
TODO:  Investigate these: 

 Microsoft Planner.  Part of Microsoft Office 365 subscriptions.  Have not yet tried.  And 
now I hear that, as of 2020-04, MS Teams has been added to MS Office 365, and branded 
Microsoft 365. 

 Microsoft To Do.  A mobile app, apparently.  Have not yet tried. 
 Microsoft Wunderlist.  Going away soon/already gone — convert to something else. 

 Google Keep.  Pre-installed on later Android, free for others apparently.  Have not yet 
tried. 

 Todoist.  Have not yet tried. 
 Any.do.  Have not yet tried. 
 Habitica.  Have not yet tried. 

 Remember the Milk.  Have not yet tried. 
  

Bug tracking 
 Bugzilla from Mozilla (open source). 
 Spiceworks free, including a mobile version for your Android! 
 FogBugZ from Fog Creek Software ($, but way cool). 

 

Surveys 
 Eventbrite  Good, according to GW. 

 SurveyMonkey hard to use, according to GW. 
 Google Forms. 
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-30-  send comments to the author. 
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